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The Basics

Word is a page-oriented word-processing program. This means the program automatically determines where a new page begins, and leaves room for the top, bottom, left, and right margins. The preset (“default”) settings are page size of 8½ by 11 inches, with top and bottom margins of 1 inch, and left and right margins of 1½ inch. At the bottom of the screen is the status line, which shows your location in the document: page number, section, total page count, and cursor position (from top of the page, and line and column). As the cursor moves (either by typing, or using the arrow keys on the keyboard, or clicking with the mouse), the status line changes to reflect the position.

Once Word is on your screen, you are ready to type. No layout, format, or design instruction is necessary to begin. If you wish to change the built-in settings, do it before you type or as you type.

When working with any computer word processing program, you must not use the enter (return) key at the end of every line. Word wraps words that won't fit on one line onto the next line (called “word wrap”). Only at the end of paragraphs and where blank lines are desired should returns be inserted. “Word wraps” automatically change whenever your text changes; hard returns must be manually removed using Delete or Backspace. 
The Keyboard

Several keys on the keyboard have purposes specific to Word. The keyboard consists of four components: the alphanumeric keys (like a typewriter), the cursor movement keys (the arrows) and accompanying key functions, the numeric keypad (similar to a pocket calculator), and the function keys.

The numeric keypad is activated by pressing the “NumLock”; numbers appear when you hit those keys. If NumLock is turned off, the secondary messages—duplicating the cursor keypad—will apply. The numeric keypad is not a calculator. It will not perform mathematical operations for you in a word processor or spreadsheet; it is simply for typing numbers more efficiently.

The cursor keypad provides four arrow keys for moving the cursor around the document: up, down, left, right. Additional keys for quick moves include “End” (end of current line); “Home” (beginning of line); “Page Up” (top of screen); “Page Down” (bottom of screen); “Insert” (turns on “type​over”, so that what you are typing replaces what is already on the page); and “Delete”. The Delete key will erase whatever character is after your cursor while moving the rest of the text back one space; holding the key down continues the delete/reformat process. 

The alphanumeric keypad works like a typewriter. The 26 letters, the punctuation symbols, and the numbers and other characters are accessed by pressing the appropriate key. Holding “Shift” while pressing the key gives you the upper case letter or symbol for that key. “Caps Lock” turns on upper case letters automatically (it works only for letters, not for numbers or punctuation). 
When you use the keyboard, it is essential to use the space bar to put spaces between words; however, never use spaces to line up text. If you are accustomed to starting a paragraph with a five-space indent, you will quickly learn that no two spaces in Word match. Five spaces in one paragraph will be larger (or smaller) than five spaces in the next paragraph. To move text to a fixed point (such as a paragraph indent), you must you the “Tab” key. The automatic setting is that each time you tab, you move half an inch (the equivalent to five spaces). Therefore, if you have two columns of numbers to line up, you must use tabs to separate the two columns; you should also understand the value of tab settings (such as “decimal tabs”).
Also on the numeric keyboard is a key called “Backspace.” The Backspace key serves the same function as delete, except it erases backwards from the cursor position.

The function keys at the top of the keyboard give you shortcuts for carrying out commands. Keyboard shortcuts are identified on the pull-down menu across the top of the screen.

The Screen

At the bottom of the screen is the status line showing your position. Above the status line is a horizontal scroll bar for moving the screen left to right. In the lower left corner are “View” buttons, where you should always check to make sure “Print Layout” view is turned on (if you want an accurate view of your document).

At the right side of the screen is a vertical scroll bar for moving up and down. Moving with the scroll bar does not move the cursor location. The scroll bars can be used three different ways. You can click on the arrows to move line by line, you can pull the box (“elevator”) on the bar to go to the top or bottom of the document, or you can click on the blank area to move screen-up or screen-down (or left or right). 
At the bottom of the right scroll bar are two double-arrows; these are “page up” and “page down” commands for moving an entire page at a time. In between is a circle which provides alternate “go-to” shortcuts.
The top of the screen is divided into four parts. The top line (blue) shows you the title of your document. In the upper left corner (the “W” symbol) is the Windows control panel to close Word, and in the upper right corner are the Windows arrow icons for minimizing and maximizing/restoring Word. 

Below the title line is the menu. The menu lists all choices. Below the menu are two toolbars containing “buttons.” The first toolbar XE "toolbar"  is called the “standard” toolbar because it works similarly in all Microsoft products. The second toolbar is called the “format” toolbar and it is used for formatting text.Note that you might initially see only one long toolbar, with >> indicating more choices off the edge. If you do not see two lines, be sure to go to Tools/Customize and check the box that says “Show toolbars on two rows.” You will probably also want to select the option to show full menus on the same screen.

· Standard toolbar XE "toolbar" 
New Document
Print
Cut
Undo
Insert Link
Columns
Show
Open Document
Print Preview
Copy
Redo
Draw Table
Graphics
Zoom
Save Document
Spell Check
Paste

Insert Table
Doc Map
Help
Permissions
Research
Format Painter

Excel

Read
Email (Outlook)

· Formatting toolbar XE "toolbar" 
Styles
 & Formatting
Font
Bold
Left Align
Auto Numbers
Borders
Style

Size
Italic
Center
Auto Bullets
Highlight



Underline
Right Align
Unindent
Color (text)




Justify
Indent
Add or Remove




Spacing

To use a feature, click it (once) with the pointer. For example, to turn on bold, point the mouse arrow at it and click the center of the “B.” To turn it off, click the “B” again. Some buttons have “pull-downs XE "pulldowns" ” with choices, indicated by a downward pointing arrow; click the arrow for options.

Another important selection under “View” is the ruler bar. The ruler shows tabs, indents, and margins—and allows you to change them.

Menus 

The menus XE "menus"  can be accessed by pointing and clicking with the mouse (note, you do not have to hold and drag the mouse button to get to a menu item, as you would on a Macintosh), or through the keyboard. To use the keyboard, hit your ALT key to move the cursor to the menu, then arrow to the choice desired; arrow down to see the options; arrow to any option and press enter to select it. Or, press ALT plus whichever letter is underlined to go straight to that item (for example, ALT+A to go to Table); then press the underlined menu letter to carry out the choice (you do not have to press ALT or enter).

Many menus XE "menus"  provide “tab windows”—a series of windows. Tabs XE "Tabs"  show options across the top of the window for different choices. Click to see the choices, or use alt plus the underlined letter.

Mouse Commands

To select a particular area of text to format, use your mouse or your keyboard to highlight it. The basic mouse move to highlight is point, click, and drag the mouse. Don't let go of the mouse button until you get exactly what you want highlighted. Once you've released the mouse button, if the highlight is not correct, you have to restart. Click on any text to turn off the highlight. Quick highlights can be done with the following mouse commands:

· Click — Position cursor.

· Click, Hold, and Drag — Position cursor and highlight; drag down (not over) to move from line to line.

· Double click—Point at a word and click twice to highlight the entire word.

· Triple click—Point at any word and click three times to highlight the entire paragraph.

You can also highlight by pointing and clicking in the left margin. Clicking once in the margin highlights one line. Clicking twice in the margin highlights one paragraph. Clicking three times in the left margin highlights the entire document. You can highlight line-by-line by pointing in the margin, clicking and holding, then pulling the mouse down or up. Other mouse commands include these:

· Click in Left Margin—Line highlight. (Be sure the mouse symbol is an arrow.)

· Double Click in Left Margin—Paragraph highlight.

· Triple Click in Left Margin—Document (global) highlight.

· Ctrl Click—Select sentence.

· Shift Click—“Range extend.” First, position your cursor at the beginning of what you wish to highlight. Then, point at the end of the desired highlight area, hold the shift key, and click. Everything from cursor to the point-position is highlighted.

· Alt+Shift Click—Create a block (useful for tabular columns).

Highlighting Text with Keys

Highlighting text in Word allows you to carry out specific functions (such as underline, bold, center, move) on what is highlighted. You can highlight with the keyboard as well as the mouse. To use the keyboard, hold the shift key and use your cursor arrows to move around. As you move with the arrows, the text is highlighted. To undo the highlight, let go of the shift key and move with the cursor arrow.

An alternative way to highlight with the mouse is to click to position your cursor, hold the shift key and click at a second area of the screen. Everything in between will be highlighted for you.

· Shift-Arrow — Highlight text

· Control-Shift-Arrow — Highlight text word by word

· Shift-Home — Highlight to beginning of line

· Shift-End — Highlight to end of line

· Ctrl-Shift-Home — Highlight to top of document from cursor

· Ctr-Shift-End — Highlight to end of document from cursor

Inserting and Removing Text

To type new text into text already typed, the most important rule is to position your cursor exactly at the point where the new text goes. Remember: the mouse is not the cursor. 
There are three ways to remove text. Delete removes text following your cursor. Backspace removes text backwards from your cursor. If text is highlighted, pressing any key that types deletes what is highlighted. 

Keypad Moves 

· Arrow Keys — Move character-by-character or line-by-line

· Control-Arrow — Move word-by-word (left, right) or paragraph (up, down)

· Home — Move to beginning of line

· End — Move to end of line

· Insert — Turns on “typeover” mode to replace text already on screen (the clue is a tiny “OVR” symbol at the bottom of your screen)
· Control+Home — Move to beginning of document

· Control+End — Move to end of document

· Page Up/Down—Move screen by screen

· Paragraph Breaks — Enter

· Page Breaks — Ctrl-Enter

· Hard Spaces — Ctrl-Spacebar (non-breaking spaces)

· Shift-Arrow — Highlight text

· Control-Shift-Arrow — Highlight text word by word

· Shift-Home — Highlight to beginning of line

· Shift-End — Highlight to end of line

· Ctrl-Shift-Home — Highlight to top of document from cursor

· Ctr-Shift-End — Highlight to end of document from cursor

· Paragraph Breaks — Enter

· Page Breaks — Ctrl-Enter

· Line Breaks (same paragraph)— Shift-Enter
Control (command) key shortcuts XE "shortcuts" 


a
Select (highlight) all



b
Bold


c
Copy



d
Fonts



e
Center



f
Find



g
Go to



h
Replace



i
Italic


j
Justified left to right



k
Insert hyperlink



l
Left align



m
Indent



n
New document



o
Open document



p
Print



q
Redo



r
Right align



s
Save



t
Hanging indent



u
Continuous underline



v
Paste



w
Close document



x
Cut



y
Repeat



z
Undo



1
Single space



2
Double space



5
1.5 space



space
Reset to normal



+
Superscript



=
Subscript



-
Discretionary hyphen
File Management 

“New” versus “Open”—Open retrieves a document already on the disk XE "retrieves a document already on the disk" . New starts a document from scratch. If a document is currently in use, “New” does not clear it from the screen. The first document goes into a window (workspace), and the new document goes in a new window; you can switch between them by using the window menu option (see below).

“Save XE "Save" “ versus “Save as”—”Save” saves the current document XE "saves the current document" , asking for a filename that can be up to 256 characters in size (Microsoft Word for Windows automati​cally adds a 3-character extension, “.DOC” that should not be changed). If the document has already been saved, pressing “save” simply resaves it with no questions asked. “Save as” allows you to save a document under a dif​ferent name (change the name), creating an extra copy. It also gives you an option (at the bottom) to specify file format (such as “Rich Text Format” or “WordPerfect Format” for exporting). One of the important choices available is “template” format, so you can reuse the template without losing the original document. Finally, the screen gives you a pulldown (at the top) to specify location (desktop, disk, or foler).
“Close” versus “Exit”—”Close” closes the window currently open. “Exit” closes all windows and quits Word. If document(s) have not been saved, both commands prompt you to save your work.

Viewing Your Document

The “View” menu gives you three different ways to look at your document:

· Normal—Draft mode, which means you don't see the page margins or breaks, but you do still see font changes. Headers and footer are usually easier to work with in normal view.

· Web layout—Used to convert a Word document into an HTML web page.

· Print Layout—WYSIWYG: What you see is what you get.

· Reading Layout—The Reader’s Digest approach, big print, small pages, to make the document easier to read (has no impact on printing).
· Outline—Adds a special tool bar for typing outlines.

 “V​​​​iew” also allows you to turn on or off your tool bars and ruler. Other choices are for accessing the “Tastk Pane,” creating headers and footers (text to be repeated at the top or bottom of every page), seeing the full screen document (no menus XE "menus"  or tools), and “zoom” for zooming in or out on a page.

The Task Pane

The right side of the Word viewing screen is called the “Task Pane.” The Task Pane serves a multitude of functions, including access to templates, clip art, and styles and formats. At the top is a pull-down, with choices for:

· Getting Started—Open documents, create a new document.
· Help
Search Results—Look for information at Microsoft Office online.
· Clip Art—Search for clip art.
· Research—Find information in Microsoft products (including “translate”).
· Clipboard—Holding area for cut-and-paste.
· New Document—Blank documents and templates.
· Shared Workspace/Document Updates/Protect Document—All require Microsoft “Rights Management.”
· Styles and Formatting—Available and used styles.
· Reveal Formatting—Show and edit formatting for text.
· Mail Merge—Mail merge wizard.
· XML Structure—generating a web-structured page.
Moving Text

The basic way to move text XE "move text"  around within your document involves a cut-and-paste XE "cut-and-paste"  operation, lo​cated under the “Edit” menu. To move text, first highlight it, then use Edit and chose the option called “Cut,” which will remove your text from the screen (sending it to the Windows clipboard); alternatively, use “Copy” to make a copy of the text for moving while leaving the original. 

Then, move your cursor to the point in the document where you would like to have the cut/copied text to be placed. Once again, use Edit to “Paste” the text back into your document. All following text will move down to leave room for it.

You can only have one section of cut text active at any one time. When cut (or copied), it is stored in the Windows clipboard, viewable in the Task Pane at the right of the screen. Paste does not clear what is in the clipboard. This means you can paste the same text over and over.

You can also cut/copy and paste using the scissors, double-page, and clipboard buttons on your toolbar, or Ctrl+X (cut), C (copy), and V (paste) on your keyboard.

Cut and paste also works across documents, and across programs. However, if you use “Paste Special” (on the Edit menu), you will find all sorts of options about how you want to paste your item, including a command to “link” to the original, so that if the original changes, so does the copy you’ve pasted.
Remember, if you cut something and then realize you made a mistake, use the Edit “Undo” feature to put it back the way it was!

An alternative way to move text within a document is to highlight it, release the mouse, then click and drag the highlighted area. With the text highlighted, point your mouse at the middle of the highlighted area, click (don't let go of the mouse button), and pull the text to the new spot where you want it relocated. Watch the shadow cursor (not the little box, which indicates “move”). This is called “drag and drop XE "drag and drop" .”
Word also includes a feature called “spike” that lets you use Ctrl+F3 to cut multiple items to temporary memory, then hit Ctrl+Shift+F3 to paste them all at once.

Formatting the Document

Remember that Word is easier if you first use “View/Print Layout” and then go to “Tools/Options” to turn on “text boundaries” to see margins on the page. Remember the key rule in Microsoft Word: formats are divided into four levels.

	Level
	What It Affects
	Available operations

	1. Font
	Cursor Position or
Highlighted Area or

Automatic Word Select
	Bold, Italic, Underline

Font, Size, Super/Subscript

Cut and Paste

	2. Paragraph
	Enter (return)
	Spacing

Bullets

Tabs XE "Tabs" 

Numbers

Indents

Borders, Styles

	3. Section
	“Insert/Break/Section” (section the cursor is in)
	(same as Document)

	4. Document
	Everything
	Paper size

Orientation (landscape, portrait)

Margins (top, bottom, left, right)

Page numbers, Headers/footers

Columns


On the “Format” menu are the following options:

Font—Character formats

Font—Type style


Point size—Height and width of type


Color—If you have a color printer or monitor


Print attributes—shadow, outline, all caps, etc.

Underline (word only, spaces between words, double), and Underline color

Position: (Normal, Superscript, Subscript)


[Tab Window]Character spacing (spread characters further apart; squeeze):


[Tab Window] Animated text

Paragraph—These settings affect the entire paragraph where your cursor is, regardless of what is highlighted. Notice that this screen is a “tab window XE "tab window" .” (Also see “Ruler” below.)

Alignment (Left, Center, Right, Justified)


Indents:



From left margin



From right margin


First line indent (can be negative, to achieve a hanging in​dent; otherwise, a positive number is the paragraph indent)


Spacing:



Before 

(lines blank before or 



After

after paragraph)



Line (Fixed line height; if height is smaller than letters, lines will overlap)


[Tab Windows] Line and Page Breaks



Widow/Orphan control



Keep lines together (don't let page break interfere)



Keep with next (keep two paragraphs together)



Insert page break before paragraph

Tabs—This “paragraph format” allows you to clear all tabs, set tabs, turn on dot or underline leaders for specific tabs, and change tab alignments. (See the section on Ruler below for more about tabs.) XE "Tabs" 
Tab Position—Specify position on ruler where you want tabs to be set. When you type in a tab number, use the “Set” menu op​tion to put that tab into the specification box (the blank area that shows where all tabs manually set are located). For each tab to be set, specify the following:

Alignment (any mixture of these can be combined on a line):


Left--Line up flush left at the tab position.


Center--Center at the tab position.


Right--Line up flush right at the tab position.


Decimal--Align on decimal point (useful for numbers)

Leader (characters that lead from one tab to the next):


(1)
None


(2)
. . . (periods)


(3)
----- (hyphens)


(4)
____ (underscore)

Other menu choices allow you to clear a specified tab, clear all tabs, cancel the operation, or OK it when done.

Borders put lines around text (at the top, bottom, left, and/or right of paragraphs or pages), as well as shades of gray. Borders also turn on the grid lines for tables. 
Section (under “Insert”) XE "Section"  breaks the document into parts, so you can start renumbering or change the margins in the middle of a page. Sections are defined by section breaks, located under the Insert menu. The layout menu allows you to specify which section you want to format, and how you want it to vertically align. Format/Columns XE "Columns"  are also a section format, providing:



Columns—How many columns do you want to have.




Number—Number of columns on page




Spacing—How much blank space between columns




Line between—Line separating columns from each other



Column Start—Start a new column (column break)



Apply columns to:




This section




This point forward




Whole document




Per page, per section, continue

Document commands are on the File menu, under Page Setup XE "Page Setup" , which offers layout for the overall document (unless it is divided into sections). These include Margins (Top, Bottom, Left, Right); Size and orientation (portrait or landscape, built-in sizes such as envelopes); and Paper source.
Reveal Formatting

On the Task Pane’s pull-down is an option called “Reveal Formatting.” This screen shows you the formats currently being used for whatever text you have clicked on. They are separated into the big three categories: font, paragraph, and section. Within each, there is a hyperlink (blue underlined words) to take you to that format location so it can be edited. Click the hyperlink for font, language, alignment, indentation, borders, margins, etc. to change that setting. 
Using the Ruler

Indents, hanging indents, 
and margins

· Right Paragraph Indent


The right triangle controls the right margin of the selected paragraph.

· Left Paragraph Indent 


The square box at the left will indent the entire paragraph. When you drag it, all parts of the left move.

· Paragraph Indent


Above the square box is a triangle (like the roof on a house), which indents the entire paragraph except for the first line.

· First-Line Indent


At the top of the ruler (above the left house shape) is a downward pointing arrow, which indents only the first line of the paragraph (including bullets and numbers, useful for setting up “hanging indents”).

· Right Margin


The right edge (where the white meets the gray on the ruler, above the house-shape) controls the right margin of the entire document.

· Left Margin


When the pointer sits between the first-line indent and paragraph indent triangles, and becomes a double-arrow, this changes the margin of the entire document. The margin is measured by watching the number in the gray area, not the white area.

Tabs XE "Tabs"  

Tabs XE "Tabs"  are used to make text line up at specific positions on the page, such as for forms or for numbers that must align on the decimal point. Tabs are set on the ruler, using the “L” button on the far-left side of the ruler.

To set tabs, first click on which kind of tab you would like to set: Left, Center, Right, or Decimal (the menu also includes a type called “bar”). After you have selected a tab type, click on the ruler with your mouse to position the tab. If you don't like where it is, pull it with your mouse to a different location. If you want to remove it, click and pull it down off the ruler. Under the “Format/Tabs XE "Tabs"  “ menu, is a menu for tabs that lets you specify dot leaders and underlines between tabs, as well as clear all tabs.


Sample tabs:

Bar>
Left
Right
Center
Decimal.
 <Bar


ABCDE
FGHIJKLM
NOPQR
234.56


XYZ
ABC
DEF
1.11


JKLJKL
YUOI
HJKLT
789987.89

If you press enter at the end of the line (start a new paragraph), you carry your tab settings with you to the next line. If you arrow up or down to a new paragraph (or click on a new paragraph), you leave the tab settings behind.

Tables XE "Tables" 
Tables XE "Tables"  are an alternative to tabs for lining text up. They are created by clicking and dragging the Table button on the Standard toolbar XE "toolbar"  to the size of the table you wish to create.

	
	
	
	
	

	
	
	
	
	


This creates a series of “cells” that can contain text or numbers. If you wish to adjust the size of a column, you can pull the on-screen borders or adjust the “checks” on the ruler. Tabbing adds rows to the table. Tables can also be used to “sum” columns of numbers (you will find the Sum Σ button on the toolbar button called “Tables and Borders”). See below for more about tables.
Typing Shortcuts
Numbers, Bullets, and Indents

There are four buttons side-by-side on the format toolbar XE "toolbar"  to control paragraph numbers, bullets, and indents.

The 1-2-3 button turns on automatic numbering; the numeric format (3 or III or iii) can be specified under the Format/”Bullets and Numbering” menu. Each time you hit enter you get another number. If you hit enter twice, or click the button again, the numbering is turned off.

The ((( button works the same way, including picking the shape to use.

To indent a bulleted or numbered paragraph, use the fourth button in the series, called “Increase Indent”; each type you click it, your paragraph moves another tab’s distance (1/2-inch) in. If you go too far, use the “Decrease Indent.”

To leave a blank space between bulleted or numbered paragraphs, do not use an extra enter, since that will turn off the bullet or number. Instead, use Format/Paragraph to change the spacing before or after (i.e., between) paragraphs.

Envelopes and Labels

If you need to print an envelope XE "envelope"  or label XE "label"  as part of a letter, you do not have to highlight the address unless there is more than one. Go to “Tools/Envelopes and Labels” and use the tab window XE "tab window"  to select which format you prefer.

Under Envelopes, you will have a dialogue box that should automatically show the mailing address from the letter. There is an optional return address that can be omitted by clicking the “omit” box. There is also an address book for storing and re-using addresses if Microsoft Outlook is installed on your system.

Under Envelope/Options, you can specify what size envelope to print, what font and position to use for the addresses, and whether to use the post office bar code for quicker delivery. 
Then you can decide whether to print the envelope straight to the printer, or add it to the letter to save it for future use.

The Label window is very similar. However, at the bottom of the window are two other options: print a full page of the same address (a sheet of labels to the same person), or print one label on the page (to re-use a partially used set of labels, which requires you to specify which column and row on the sheet to use). You can specify the label format through the Options button.

AutoCorrect

This function automatically corrects typos when you make them. Although many typos are built in to Word (such as switch “adn” to “and”), you can tell it your favorites by using the “Tools/Auto Correct Options” menu. There are two steps: enter the error you wish to have replaced, and then enter what you want to replace it with. Then you “add” your entry.

Under AutoCorrect Options are many other features that many Word users find annoying. AutoCorrect is where you turn off features such as automatic capitalization at the beginning of sentences, or set first and left indent with tabs and indents.
AutoText

AutoText XE "Autotext"  is blocks of text (including formating) that you want Microsoft Word to insert for you automatically, and remember for future use. To create an AutoText entry, first type your text, highlight it, then use the “AutoText” entry under “Insert/AutoText/New” to store it. The entry must be given a unique name (up to 38 characters). Then, whenever you want to in​sert this stored text into any document, go to the Insert/Autotext entry and click on the “Normal” option to find your listing; then click on the one you wish to insert. (A shortcut for accessing the Autotext entries is to type the name into your document, then press F3; this converts the Autotext. You may also see Word “volunteering” the entry in a yellow cue card; if you wish to insert it, press enter and it goes in to your cursor.)

Fields

Fields XE "Fields"  are shortcut commands built into Word. These have dozens of operations, several of which are regularly useful, including:

· {PAGE}
Inserts page number, especially for headers and footers.

· {DATE}
Inserts computer's date; see also Insert/Date on the menu.

· {FILENAME \p}
Show/print the filename (with path) in your document.

Special Commands

Insert (Other Options)

· Break—End a line, column, page, section.

· Page numbers XE "Page numbers" —Specify position and alignment for automatic numbering. Automatically inserts a page number into the document at the designated position. Also allows you to turn off numbering for the first page, as well as indicate what number Word should start counting with. (This will affect your headers and footers also, and is controlled by sections.)
· Date and Time—Inserts the current date and/or time at your cursor position. At the bottom of the window is an option you can turn on or off that will insert the date or time as an automatic “update field.” This tells Word to update the date whenever you next work on this document; you will still see the old date on the screen, but the current date will print.

· Symbol XE "Symbol" — Special characters, such as ½(((((((. Note that each character can be assigned to a keyboard shortcut (such as Ctrl+Alt+a). Symbols differ depending on the font selected. The fonts called Symbols and Wingdings give you the most options. Under “Special characters” you’ll find symbols such as §©®¶…—. Any of these can be assigned to a shortcut key.

· Comment—Inserts and views hidden notes at your cursor position and elsewhere within the document. (This is Word’s answer to “post-it” notes.)
References

· Footnote XE "Footnote" 

XE "Footnote"— Puts a footnote at the bottom of your current page or an endnote at the end of your document. It also automatically puts a superscript number or letter in your text to indicate the note; this number updates whenever needed, as footnotes are added or deleted. To delete a footnote, simply delete the superscript in the text; the entire note will be removed. To format footnotes, go into “Style.” (In normal view, the screen splits in half, with the bottom half becoming your footnote typing area; added to the screen are shortcut fields for date, time, and page.)
· Cross-Reference—Allows you to insert a link in your text to another page, heading, footnote, or table, so that if the target changes (for example, page 3 may be page 4 or 5 when you’re done), the reference updates automatically.
· Index and Tables XE "Tables" —Label a highlighted word(s) for inclusion in an index, create the index and insert it at end of document; create a table of contents or table of authorities.

Inserting Tables of Authorities, Index, and Contents

To put a citation into a Table of Authorities (ToA), first highlight the entry, then go to Insert/References/Index and Tables. Select Table of Authorities, then click “Mark Citation.” This will take you to a screen where you can search for additional cites or automatically have Word “mark all.” Close when you have marked all necessary cites. When finished, go back to “Insert/Index and Tables,” pick a format, and then tell it OK. At your cursor position, Word will generate the Table.

The same steps apply for generating Tables of Contents and Indexes.

If you do not like the format Word applies to the table, do not try to format the table manually. Since these “tables” are an automatically updated function (i.e., printed page numbers change whenever your text changes), be sure to make format changes through “Style” using the appropriate styles.

Objects

· Picture—Insert graphics from the clipart gallery or other source. You can also use this option to acquire graphics from another location, such as a scanner or digital camera.

· Diagram—Insert organizational chart, pyramid, Venn diagram, more.
· Text box—Create a box to hold text that other text will wrap around.
· File—Merge documents.
· Object—Inserts equations, Word Art, Excel, or other items that can be imported into Word (such as graphics). 

· Bookmark—”Jump” or skip commands. You can set a bookmark, then jump to it with this same menu, or by double-clicking on the page number on the status line (bottom of screen). You can accomplish a similar function by using the round button at the bottom-right corner of the scroll bar, which gives you multiple ways to browse your document (such as page-to-page). You can also use the standard toolbar button called “Document Map” if you have been working with styles to move from heading to heading within the document.

· Hyperlink—Web or email address.

Tools

Spelling XE "Spelling" —The spell checker checks words in your document that are not rec​ognized by WinWord. Using the “Suggested” box, WinWord will provide you with options for correcting the unrecognized word. If you start in the middle of a document, there is also an option to cycle back to the beginning to continue the checking. If a word is correct, use “Ignore.” If it is correct but you wish to add it to the dictionary so it is ignored in the future, use “Add.” If it is incorrect, either click on the correct spelling or type it in, then use the “Replace” option.

Grammar XE "Grammar" —Checks your grammar, and queries you on any questionable word usage or sentence construction.

LanguageXE "Thesaurus"—This function gives you a thesaurus to look up synonyms (and antonyms) for whichever word your cursor is at (or a word to be specified). Menu options show how a word is used and its definitions, allow you to look up other synonyms, and replace the word with any of the suggested screen possibilities.

“Hyphenation” will check your document for any word that falls with 0.25 of an inch within the right-hand margin, and then hyphenate it. If “Manual” is clicked, then Word will prompt you each time a word needs to be hyphenated. You have the option to reposition the hyphen, tell Word not to hyphenate the word at all, or cancel the function. When the word to be hyphenated shows on the screen, Word will show you where the hyphen is going to be plaXE "Thesaurus" \r "End"ced, based on the internal dictionary.

Macros—The MacroXE "Macro" function under “Tools” is very similar to the “Edit/Autotext” function, except that it includes mouse or keyboard moves and format. To begin the macro process, use “Record Macro.” This will require you to enter a name for the macro. When you OK the procedure, Word begins recording your actions. When you have completed whatever you wish to do, go into the Macro menu again and stop the recording.

To use a macro that has been recorded, use the “Run” choice. Other options allow you to assign the macro to a key or to the menu (including specifying which menu choice you want it filed under and writing a description of it for the status line); other options allow you to assign the macro to a particular key combination.

Customize—The command to change the buttons on your toolbars.

Options—Any settings you would like to change permanently in Word can be done here. This represents “defaults” (except for text [stored in glossaries] and formats [stored in template]). Important options allow you to correct your name and address, turn on margins, and establish default file directories.
Table

The table XE "table"  menu (or the “Insert Table” button on the standard toolbar XE "toolbar" ) creates tables at your cursor. Any table must consist of “columns” (down the screen) and “rows” (across the screen). The table menu allows you to go back to a table and change its size, format, etc.

Any time you need text to line up side-by-side, or it needs to wrap, you should use tables instead of tabs. For example, an evaluation for staff performance could easily be set up using multiple table columns (as opposed to tabs or columns).

“Change column size” is done by dragging the cross-hatches on the ruler or dragging the table grid lines. More cells are added by pressing the tab key, or by using the “Table” menu to insert rows or columns. 

The table format (lines) can be controlled by adjusting your borders, or by using the choice called “Autoformat” on the “Table” menu. Autoformat provides pre-designed “looks” to a particular table, including various combinations of lines, patterns, shades, and colors.

Sample Table

	Name
	Good comments
	Negative comments
	Recommendation

	Mary Smith
	Is always on time; has a professional presence; works hard at job.
	Drinks too much coffee.
	Give her a vacation and raise.

	Joe Brown
	Friend of the director.
	Comes in late. Takes long lunches. Leaves early.
	Transfer to a different department.


If you need to add up (total) a column of numbers, first position your cursor in the block (“cell”) where your total should go. Then use the “Formula” option on the “Table” menu. Formula will suggest an appropriate equation, such as “=SUM(ABOVE)”. If the suggested calculation is correct, click on OK.

Tables from Excel

Tables can also be inserted from Excel. A button on the top toolbar called “Insert MS Excel worksheet” will set up an Excel table in your Word document. Alternatively, you can go into Excel, do your table with all needed calculations, save it, and then highlight it. One you have the entire table highlighted, use the “Edit/Copy” command (or copy button) to send it to the clipboard. Then switch to Word (Alt + Tab). Put your cursor where you want the table to go, and then paste it in. If you would like to establish a link back to Excel—so that the table in Word is updated whenever you change it in Excel—use “Edit/Paste Special” and select link.

Tables can also be alphabetized or put in numerical order, ascending or descending (see menu “Table/Sort”). To alphabetize by last name first, then first name, the names must be separated into different columns of a table; Word sorts from left to right, so put the last name first. Then use Sort to put them into ascending or descending order.

“Tables and Borders” Button

[image: image7.wmf]An alternative way to generate tables is to draw them with the “Tables and Borders” button (the one that looks like a grid with a pencil on it). This allows you to free-hand a table, which makes custom shapes much easier to design. The “tables and borders” toolbar gives you pencil (draw table); eraser (erase a cell line); 1/2 (thickness of line); black pencil (color of line); outside border (turn on/off lines); paintbucket (fill color); and buttons to position and sort contents. There is also a sum (total) button.

Outlines (“View”)

This screen provide you with an extra toolbar for typing outline formats. The first two buttons (blue arrows) are the same as hitting tab and shift + tab: they indent and unindent levels.

Level 1

Level 2

Level 3

Level 4

The third button (double-blue arrow) turns an entry into “text”, which means it will not be numbered. The up and down arrows move an entry up or down your list (also done by dragging the plus or minus at the beginning of each paragraph). The plus (expand) and minus (collapse) buttons show the subentries for any level, or hide the sublevels. The numbered buttons tell Word which levels you wish to view or include in your printout. “All” turns on all the levels. The double-line button turns on only the first line for each level. The A/A button shows or hides the format for the entry (to see how the format will actually print, turn on Page Layout view). The final button allows you to embed one document within another document.

Outline levels’ formats are controlled by “Styles” (see below). As you type in each level, notice the style box changes to reflect that particular heading level. If you don’t like the format Word is supplying, don’t change the outline—change the style.

To activate the numbering system you want to use, put your cursor at the top of the outline, then go to “Format/Heading Numbering” and select the your format. Note there is a modify button, which lets you customize and create your own numbering system.

Window

· New Window XE "Window" —Create another copy of same document.

· Arrange All—Split screen equally between all active documents.

· Split—Divide current document into two screens.

At the bottom of the menu is a list of open documents to move to, representing all currently active documents.

Advanced Formats

Format painter

Copies a format from highlighted text, then pastes it to another highlighted area. To use the painter, first highlight the text whose format you want to copy; then click the painter button. Next, scroll to the area of text that you want to re-format in the new style, and highlight it. This stops the painter (it will only do one selected area at a time; you must re-click the painter to do a second area).

Bullets and numbering (“Format”)

Formats for how the bullets/numbers look, including custom bullets such as (((((.

Drop cap (“Format”)

Enlarge the first letter of a paragraph and wrap text around it. Note that this function will not work with tabs before the letter since it “frames” the first space on the line.

Change case (“Format”)

Switch from upper to lower case, sentence case, title case, or toggle (opposite of current case). 

Sections and “Insert/Breaks”

Sections are commands to divide a document into parts that can be formatted separately for columns and page numbers (such as a document with a cover page that should not be numbered, and the second page should be page number 1).

Columns (“Format”)

This button separates document into multiple, newspaper-style columns. The “Format” menu for columns includes options for margins and a line between columns. To put columns into part of a document, the document must be divided into “sections” with “continuous” breaks.

Headers and footers (“View”) 
with page numbers (“Insert”)

Headers go at the top of pages, and can contain text, date, page number, and rule line. Footers go at the bottom. Two page number tabs are already set for centering and flush right. (Important: Remember that headers, footers, and page numbers are controlled by section breaks.) The toolbar for this function has the following options:

1. Switch between header and footer

2. Show the previous header/footer

3. Show the next header/footer

4. Keep this header same as previous section

5. Insert page number

6. Insert current date

7. Insert current time

8. Page setup

9. Show/hide document text

10. Close the header/footer toolbar

The “Insert/Page Numbers” menu allows you to choose a number location (top or bottom, left, right, center) and whether or not to show the number on the first page. Also in this window is a “Format” button, which allows you to tell Word to continue numbering a particular section consecutively from the previous section or to start re-numbering the current section from page one within the document (useful when you have a cover page, table of contents, then want the third page to be numbered page one). 

Working with Styles

Styles are saved formats that can be re-used. The important thing to know about styles is that Word uses them whether you do or not, and many functions in Word (such as Table of Contents) will not work without styles. Every feature of Word has an assigned style, such as page numbers, headers and footers, footnotes and endnotes, and envelopes and labels. When you start a new document, you are already using a style called “Normal.”
Styles can be edited. It is important to understand in Word that if you do not like what a style is doing to your text, don’t change the text—change the style! 

On the Formatting toolbar, the first button is called “Styles and Formatting.” Clicking it loads the styles for Microsoft Word into the Task Pane.

At the top of the “Styles and Formatting” Task Pane is a box showing you the formatting used for your current text (there are also commands to “Select All” occurrences of that format in your document, so it can be globally modified). The box with your current formatting will show you a pull-down when you move your mouse to it (the pull-down does not show automatically). On the pull-down you will find choices to select all, clear the formatting, create a new style, modify the style, or reveal formatting for editing the format.

Editing Styles and New Styles
Since styles are ways to store your formats for re-use, you can either create new styles or edit (“modify”) existing styles (you can also highlight an area of text with a desired format, then click on the style box to get a menu to “redefine” the style on the highlighted text).

· New Style—Requires you to specify a name (which shows on the format toolbar); a style type (change the paragraph or just the highlighted area); based on (used other style as base format); and style following paragraph (the next style to switch to when you hit enter). Then you change the format.

· Modify Style—Change an existing style. The format option gives you choices to change

· Font—allows you to specify font, font size, color, position (super/subscript), characteristics (bold, italics, small caps, underline, etc.), and spacing (normal, expanded, or condensed).

· Paragraph— formats specify paragraph alignment (left, center, right, justi​fied), indents (left, right, first line), spacing (before or after, or between lines), based on style, border (box or bar), keep together, page break before, and line numbering

· Tabs—tab settings for the style

· Borders—sets borders and shades around the paragraph

· Language—codes text so Word will use different language spell checkers

· Frame—creates “cutouts”

· Numbering—automatic numbers

Shortcut key (assign an keyboard combination to run the style, such as Ctrl+Sh+I)

Unless otherwise specified, styles are paragraph formats, and automatically affect the entire paragraph. 
The automatic setting is that a style is available only in the document on which you are working. If you wish to make a style available in other documents, you must add it to a template; then you will have access to it any time you are working on a document based on that template.

Changing Your Default Format

To change your automatic (default) type format in Word, use “Style” to redefine your “normal” style. Be sure to check “add to template” so it is saved in the “normal” template. Also, exit Word in order to save all changes to the styles and templates.

Format/Autoformat

Reformats your document for you, based on styles.

Templates

Just as there is never a time in Word when you are not in a style, the same is true of Templates. Templates are pre-formatted documents that can be re-used. They hold the paper size, margins, headers/footers/page numbers, columns, and styles. Any time you select a template, you automatically get a new document.
Word supplies a large variety of built-in templates, along with “wizards” that walk you through the steps to use the template. You activate them by using “File/New” or the Task Pane pull-down for “New Document.” Choosing a template creates a new, unnamed copy of the original’s content on your screen (which many people erroneously try to do by using “Save as”).
To make your own templates, create a document as usual. However, instead of saving it as a document, when you press Save, change the file type (bottom choice on the save screen) to read “Word template.” This accomplishes two outcomes: the filename now ends in .DOT (instead of .DOC), and the folder now reads \TEMPLATE. Once you click OK, your template is added to the list you see when you click on “File/New.”

Macros

Macros are shortcuts that the computer records for future playback. First you must assign a name to the macro. Then you have an option to assign it to the keyboard, menu, or toolbar, although you can skip this step and go straight to “Record” if you intend to add a button later to run your macro (see below). This causes the macro toolbar to appear on the screen. You record all steps you want the macro to remember by carrying out each step. Stop the recorder to tell Word you’ve completed your macro. Then run your macro through “Tools/Macro/Run.”

Customizing buttons

All buttons on the toolbars can be changed. “View/Toolbars” allow you to enlarge or shrink the size of the buttons, but “Tools/Customize” changes which buttons are located on each toolbar. You can also change your menus and keyboard definitions with this function. To change the tools, you must specify which category of change you wish to make (such as a menu choice or macro), then pick the button. To put a macro on the button bar, click on the macro category, then choose the macro filename; then, Word prompts you to assign a button to your macro by dragging it to where you want it positioned; there is an edit button to change it’s graphic. When you close the Customize window, you see your new buttons. (“View/Toolbars” also allows you to create new toolbars in addition to the pre-designed toolbars.)

Drawing and Graphics

All of these features are available on the graphics button (“Drawing”) on the standard toolbar or through the Insert menu.


Charts (“Insert/Picture”)

Creates pie, bar, line graphs. Data can be typed into an entry form or imported from Excel. This feature runs the Microsoft Graph 5.0. When finished, click the blank space in your document to return to your text. Double-click the chart to get back into it (don’t click back on the chart menu — that starts another chart!)

Word Art (“Insert/Picture”)

A Word function that allows you to take your text and shape it, add patterns to it, rotate it, put a shadow behind it, etc.

Clip Art (“Insert/Picture”)

Built-in artwork that can be inserted into your document, either at your cursor position or within a frame. Double-click a picture to edit your graphic. 

AutoShapes are pre-designed shapes that can be typed in. Right-click the object to add text. Double-click to format.

Mail Merge 

Mail merge is the ability to generate multiple letters, envelopes, labels, or emails, or to generate a “directory” from one list of data. To start a mail merge, go to the Tools menu, under “Letters and Mailings,” and click on “Mail Merge.” The mail merge task pane will appear on the right side of your screen.
Steps to a Basic Merge

Mail merge in Word 2003 is a “wizard”; there are 6 steps to complete the merge. Step 1 is to select the type of document you are trying to create: letters, email, envelopes, labels, directory (a directory used to be called “catalog” and compiles a formatted list from the data). Select the one you wish to do; you can only do one at a time (radio button). Then click at the bottom where the screen reads “Next: Starting document.”

Step 2 is “Select a document.” You can use the current document (whatever is currently on your screen), use a pre-existing template, or choose a different existing document (open a file). Select one, then click on “Next: Select recipients.”

Step 3 is where you specify where your data are coming from. You can use an existing list (click on “Browse” to locate a preexisting list, as long as it is either a database .MDB file, an Excel .xls file, a Word .doc file, or a delimited .txt file), select from an Outlook address book (“Choose Contacts Folder”), or type a new list (“Create”). If you click “Create,” you will see a data entry screen where you can type your information; this screen is designed to match the other steps of the wizard; if you choose not to use this form (you use “customize”) or if your data already exist from another source, you will need to do the “Match fields” in a later step.
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Once your data are entered and saved, you are given an option to “select” recipients. The following screen appears (it also appears when you click “Edit recipient list”), with check boxes next to each entry for selection. You can also click any column heading to sort (ascending or descending). You can also use the pull-down arrow next to each column heading to pick specific content or to go to “Advanced” querying or filter options and multiple level sort.
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Step 4 is “Write your letter.” Even if your letter already exists, this step is where you place your fields onto the page for the actual merge. There are pre-designed recipient information fields ready to use, based on the form screen: address block, greeting line, electronic postage, postal bar code, and more (individual fields). If your fields have not changed, you can simply select the position in your document, then click the appropriate field code to put that information in. 


If your fields are different, then you need to re-define the list of items. If you click “Address block,” for example, you will see how it is created and what it contains. In the bottom corner is the button for “match fields,” which allows you to coordinate your own field names with the built-in fields.

Note that at this step in the merge process, you also have the “merge toolbar” across the top of your screen. This is the alternative way of laying out your merge fields.
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A final letter would look something like this:
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Once you have designed your letter, you are then ready for Step 5, “Preview your letters.” Previewing gives you’re a navigation tool (<< or >>) for looking at various letters to see if you are satisfied; there is also a button to edit the recipient list and another to exclude a particularly recipient.

The final step, Step 6, is to complete the merge. To do this you can either send your merged output to the printer, or select the choice called “Edit individual letters.” This puts the letters on your screen so you can look them over, revise and customize, and then print.

Merging to Envelopes and Labels

Merging to envelopes and labels follows essentially the same steps as for a letter. For an envelope, you have the optional step of designing your envelope (where do you want the address and return address to be position, and what font and size should they be).  

For labels, you have “Label options” where you can select which label size (including name tags and postcards) to print to. The only part that is different for labels is in Step 4, where you must do a step called “Replicate labels” (or “Propagate” on the toolbar). When you design one label with your fields, you need to take that same design information and place it on all the other labels for the page. This is accomplished by clicking “Update all labels.” If you forget to do this step, you will end up with only one label.

For envelopes and labels, you can also specify use of the postal bar code, which puts the bar code for your zip codes onto the envelopes or labels.

Merging from Access

An alternate way of carrying out a mail merge is to approach it from Microsoft Access, rather than from Word. When in an Access table or an Access query, at any point you can click on “Print Preview.” On the print preview toolbar is a button called “merge with Word.” This takes the output from your Access table or query, and then runs the mail merge wizard in Word. 
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If you need to do a lot of selecting of data for your merges, this is probably a long-term easier method than trying to “filter” in Word.

© George W. Rumsey
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